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SYSERR Utility - Overview
When you develop a Natural application, you may want to separate error or information messages from
your Natural code and manage them separately. This makes it easy for you, for example, to unify
messages, to have predefined message ranges for different kinds of messages, to translate the messages
into another language or to attach a long text to a message, which explains it in more detail.

With SYSERR, you can write your own application-specific messages. In addition, you can modify the
texts of the existing Natural system messages; this is not recommended, however, because with new
Natural releases these modifications will be lost. 

Select any of the following topics depending on your operating system environment:

All Platforms 

General Information on Messages 
  

User Exit USR0020P 

Mainframes, UNIX and OpenVMS Windows 

Invoking SYSERR Invoking SYSERR 

Direct Commands Window Elements 

Parameters Converting Natural Short Messages 

Functions 

  Converting to Upper Case - ERRUPPER 

Replacing Characters - ERRCHAR 

Mainframes only Windows, UNIX and OpenVMS 

Unloading Messages - ERRULDUS Generating Message Files 

Loading Messages - ERRLODUS   
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SYSERR General Information on Messages
Message Types 
Message Languages 
Which Messages Do You Receive? 
Displaying Natural Long Messages
(not applicable to UNIX and OpenVMS)

Message Types
There are Natural system messages, which belong to Natural and there are user-defined messages attached
to libraries (including SYS-libraries). The type of message depends on the library name. 

 To access Natural system messages 

In CUI environments:
Enter a Function Code and Message Type NS or NL .
A Library name is not required and any entries are ignored. 
In GUI environments:
Select Library "<natsys>" or leave the field blank.

In all other cases, you will access user-defined messages.

There are four types of message texts which can be created and maintained with SYSERR: 

Natural short message 
Natural long message 
User-defined short message 
User-defined long message 

 To invoke a user-defined short message in a Natural program

Issue the statement "REINPUT *nnnn", where nnnn is the number of the requested message.
Or issue the statement  "INPUT WITH TEXT *nnnn" statement where nnnn is the message number.

A short message is the one-line message which is displayed in the message line to the user when the
corresponding error situation occurs. 

A long message is meant to be a detailed explanation of the corresponding short message. See also 
Displaying Natural Long Messages (not applicable to UNIX and OpenVMS).
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Message Languages
Messages can be created in up to 60 languages.

The following rules and restrictions apply: 

Natural short messages must be entered in English first, and can then be translated into any other
language. 
Natural long messages can be entered in English, but cannot be translated into other languages. 
User-defined short messages can be entered in any language, and then translated to any other
language. 
User-defined long messages can be entered in any language, but only if the corresponding short
message already exists. 

Which Messages Do You Receive?

Natural Short Messages

When requesting a Natural short message from a program, Natural looks for the requested message
number on the system file FNAT in the following order: 

1.  under the current language code as determined by the system variable *LANGUAGE, 
2.  under Language Code 1 (English). 

If neither of the above is found, you only receive the message number prefixed with NAT, for example, 
NAT0230.

User-defined Short Messages

When requesting a user-defined short message from a program, Natural first looks for the requested
message number nnnn under the current language code as determined by the system variable 
*LANGUAGE (see the Natural Reference documentation). If that message does not exist, Natural looks
for the requested message number nnnn under Language Code 1 (English). If that message does not exist
either, Natural looks for message number n000 (where n is the first digit of the requested message
number) under Language Code 1.

At first, these three search steps are performed in the current library. If nothing is found there, further
libraries are searched in the same way until a corresponding message is found.

The sequence of libraries for the search is as follows: 

1.  the current library as determined by the system variable *LIBRARY-ID, 
2.  the steplibs; if Natural Security is installed, the sequence in which the steplibs are specified in the

Natural Security profile of the current library, 
3.  the default steplib as determined by the system variable *STEPLIB, 
4.  the library SYSTEM on the system file FUSER (*), 
5.  the library SYSTEM on the system file FNAT (*). 
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(*) If the name of the current library begins with SYS, SYSTEM FNAT is searched before SYSTEM 
FUSER.

Displaying Natural Long Messages
Not applicable to UNIX and OpenVMS.

When you receive a Natural short message, you may be looking for further explanations regarding the
problem situation. Most of the short messages have corresponding long messages with additional
information and resolution instructions.

If the current library does not contain a corresponding long message, the one contained in the library
indicated by *STEPLIB is displayed.

 To display the long message of the most recent Natural short message

In GUI environments:
Choose Help from the Error dialog box.
Or enter the command "HELP nnnn"  
Or enter the command "? nnnn"
where nnnn represents the message number of up to four digits.  
In CUI (mainframe) environments:
Place the cursor in the message line and press the help key, as assigned with a SET KEY statement
(usually PF1).
Or enter the command "HELP nnnn"  
Or enter the command "? nnnn"
where n represents the message number of up to four digits.

See also the system command HELP as described in your Natural User’s Guide.

The language code of the long message displayed is the same as for the corresponding short message. If
no long message exists under that language code, the corresponding long message under Language Code 1
is displayed. If such a long message does not exist either, no long message is displayed at all.

Note for mainframes:
The library SYSEXT contains a user exit, USR2002P, which allows you to modify some elements of the
long-text display invoked with PF1 (see above).
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SYSERR Generating Message Files
Applicable to UNIX, OpenVMS and Windows only.

Storing Messages 
Creating Text Files 
Generating Messages Modules 
Recreating Text Files

Storing Messages
The messages created and maintained with the IMPORT and EXPORT commands of SYSERR are stored
in operating system directories. 

For Natural system messages, the utility SYSERR uses one or more text files (up to ten) to create a
messages module. 

For user-supplied messages, this module must be: 

NnnAPMSL.MSG

where "nn" is the language code (01 - 60). 

This module must be stored in the subdirectory ERR of either the library from which the application is
executed or the steplib or the library SYSTEM. 

User-supplied messages for a library are stored in the directory identified by the FUSER system file
assignment made in the global configuration file as described in your Natural Operations documentation
under Operations Environment (UNIX and OpenVMS) or Configuration Files (Windows). 

For Natural system messages, the module must be located in the subdirectory ERR in the Natural root
directory. 
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Creating Text Files
For Natural system messages, the IMPORT function of SYSERR generates a messages module from one
text files. 

The text files to be used must have a specific syntax, as shown in the following example: 

Example: 

 NAT 
 0010 
 0100 
 0010E NO MESSAGE TEXT DEFINED! 
 0020E MISSING/INVALID SYNTAX; UNDEFINED VARIABLE-NAME. 
 0025E ERROR IN ENTRY FOR NUMBER OF RECORDS TO BE PROCESSED. 
 0050E INCORRECT FIELD SPECIFICATION IN ’WHERE’ CLAUSE. 
 #PLEASE CHECK PROGRAM 
 #FOR ERRORS 
 0100E FUNCTION NOT AVAILABLE.

Explanation:

NAT Group ID (library name) and prefix for the number that will be displayed with the message. It
can have up to eight characters. 

0010 Four-digit starting number of the range of messages. 

0100 Four-digit ending number of the range of messages. All error numbers that are defined in this
text file must be within this range. 

0010E NO MESSAGE TEXT DEFINED.
This is the message for error number 0010. The E is mandatory and means "error". This message
will be issued with the statement "REINPUT *0010".
Explanatory long texts must be placed immediately below this message; each of these additional
lines must start with a hash/number (#) sign. Up to 20 additional lines are allowed. 
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Generating Messages Modules
Once the text files have been created, you can generate a messages module from the text files with the
SYSERR utility.

One output error file can be created for each library. Each error file must be in the ERR subdirectory of
that library.

 To generate a message text file under UNIX and OpenVMS

1.  Enter the IMPORT command of the SYSERR utility.
The "Import Text File to Message File" window is displayed. 

2.  In the From input field, specify the name of the input text file from which all information is to be 
read. 
The full path name of the file must be specified. Error number ranges must not overlap for Natural
system messages. 
In the To input fields, specify the language and the library of the output error file to be generated. 

 To generate a message text file under Windows 

See the Import Text File function of the Options menu as described in the section SYSERR Window 
Elements.

Recreating Text Files
With the SYSERR utility, you can also recreate a text file for message text maintenance. This is done by
reconverting an error messages module into a sequential text file.

 To recreate a message text file under UNIX and OpenVMS

Enter the EXPORT command of the SYSERR Utility.
The "Export Text File from Message File" window is displayed. 
In the From input fields, specify the language and the library of the message to be used as input. 
In the To input field, specify the name of the text file to be created. 
The text file created will have the same format as an input text file.

 To recreate a message text file under Windows

See the Export Message File function of the Options menu as described in the section SYSERR
Window Elements.
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Invoking SYSERR
 To invoke the SYSERR utility from the main Natural window 

1.  Enter the system command SYSERR
Or, from the Tools menu, choose Error Messages... 
Or, if you have already created error messages for a library:
from the View menu, choose Library Workspace and click on the Logical View button.
The message files are listed per language under subdirectory Error Messages in the library specified.
Double-click a message file. 

If no context information (library, language) is available, SYSERR prompts you for a library and a 
language:

2.  Choose OK. 
The SYSERR window is displayed. See the section SYSERR Window Elements.
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SYSERR Window Elements
From the SYSERR window you can invoke all commands and functions available for message 
maintenance: 

The window contains two panes. To modify the size of the window, move the mouse pointer over the right
border, showing two arrows pointing into opposite directions. Then, drag the border using the mouse until
the window has the desired size.

There are context menus available for several dialog elements. A context menu is displayed by a click
with the right mouse button on the dialog element. The available commands are either Cut and Paste
functions or correspond to the commands in the menu or to push buttons.

This section covers the following topics: 

Title Bar 
Push Buttons 
Menu Bar 
List Box 
Fields
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Title Bar
The title bar displays the 

Message type
(Natural system or user-defined) 
Selected library 
For Natural system messages, no library is displayed. 
Selected language
For more information, see the system variable *LANGUAGE in the Natural Reference 
documentation. 

Push Buttons
The following commands can be executed using push buttons:

Command Explanation 

Copy Only visible if a sample message exists. If activated, the text of the sample message is
copied into the Short field of the message. See also Fields below. 

Previous / OK Toggles between Previous and OK, depending on the status of the current message:

OK Saves the current message to the message file after modification. 

Previous  Scrolls from the current message to the previous message if no modification
was made. 

Note: You can only save a message if text was entered in the Short text field. See also
Fields below. 

Cancel / Next Toggles between Cancel and Next, depending on the status of the current message:

Cancel  Cancels modifications made to the current message and displays the original
message.  

Next Scrolls from the current message to the next message if no modification was
made. 

New Searches for the next free message number starting from the current message. Free
means that this message number is available and has not yet been assigned to a message
file in any language.

The direction of search is downwards by default, but depends on the last search
specification (perhaps upwards) executed with the New Message command of the Edit
menu.  

Short to Long Copies the text of the Short field to the first line of the Long Text field. 
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Menu Bar
The commands available with the SYSERR menu are described below. Some menu items are used to
switch between modes or set a status. The check mark next to a menu item indicates which mode or status
is active.

Below is information on: 

File Menu 
Edit Menu 
View Menu 
Options Menu 
Help Menu
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File Menu

Command Explanation 

New 
Lib/Lang

Selects a new library and/or a new language. A dialog prompts you for input.
Only libraries and languages are displayed for which no message file exists.
After you have made your selection, an empty SYSERR window appears, in which you can
enter a new message. 

Open 
Lib/Lang

Selects another library and/or another language. A dialog prompts you for input.
Only libraries and languages are displayed for which messages already exist.
After you have made your selection, you can modify the existing messages or add new
ones. 

Open File Selects an existing message file from the Natural file tree (FNAT, FUSER or Natural
system) or from another directory.

The message files are located in the Natural directories:

FUSER \<library>\ ERR 

FNAT \<library>\ ERR 

Natural \ERR 

For user-defined error messages, the file must have the name NnnAPMSL.MSG, where nn
is the language code to be used, for example 01 for English. In a Natural System message
file, the 2nd and 3rd character of the message file name are the language code, the 4th
character is the letter L, and the last four characters are the starting number of the error
message range. 

Print Invokes the print function. 

A dialog box prompts you to enter the error numbers, mark the Long Text print-out option,
specify layout parameters and the logical printer name; see the DEFINE PRINTER
statement in the Natural Statements documentation for details on logical printer names.

See also how to print all Natural system messages below. 

Exit Exit SYSERR. 

 To print all Natural system messages

1.  Select library "<natsys>" or leave the field blank. 
2.  Select language English or German. 
3.  Choose Print from the File menu:

Specify the options provided, and leave the default values for the message range (1-9999). 
4.  Choose OK.
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Edit Menu

Command  Explanation 

Cut, Copy,
Paste, Delete,
Undo

Supported clipboard functions. 

New Message Searches for the next free message number, for which no other message exists in any 
language.
Upwards/Downwards: the next lower/higher message number from the current message. 

Delete SelectedDeletes all messages selected (highlighted) in the list box. A dialog box prompts you to
confirm the action. 

Delete All Deletes all messages displayed in the list box. A dialog box prompts you to confirm the 
action.

When all messages of a message file have been deleted, the message file is deleted too. 

Read All Reads all messages from a message file into the list box in one step. This command
applies to message files with more than 200 messages. 
Otherwise, for performance reasons, only 200 messages are read by default when the
SYSERR window is started. Additional messages can be displayed scrolling down the
list box to the end or using the Read All command. 

Translate Supports the creation of error messages for different languages. Applies to short
messages only. See To translate languages below.  
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 To translate languages 

1.  From the Edit menu, choose Translate.
The Select Languages dialog box opens:

2.  Select one language or more into which you wish to translate the current message and choose OK.
Another dialog box opens:
 

Command/Fields Explanation 

Select Languages 
(Options menu)

Invokes the Select Languages item from of the Options menu to add additional
languages unless selected earlier, during Step 1 above. 

Available 
Languages

The language code(s) of the language(s) already available for the current
message number.  

Language Code and language of the new language selected. 

Short Text The text of the short message. 

Previous/OK Same as described for Previous/OK under Push Buttons. 

Cancel/Next Same as described for Cancel/Next under Push Buttons. 

Help Display SYSERR help text. 

3.  Enter the translation in the Short Text field of the relevant language. 
4.  Choose OK.

The language code of the new language appears under Available Languages.
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The language of the current short message (in the example above English) is always listed in the first
position of the translation dialog.

View Menu

Command Explanation 

Languages 
Display

Enables/disables the Languages Display. The Languages Display gives an overview of
all available languages for one message number. Default is the Compressed display as
described below. 

Compressed Applies to the Languages Display command. See Compressed below. 

Extended 
Short

Applies to the Languages Display command. 
Enables/disables the code display of languages in which the short texts exist next to the
error number. 

Extended 
Long

Applies to the Languages Display command. 
Enables/disables the code display of languages in which the long texts exist next to the
error number. 

Filter Display Applies to the Set Filter function described under To activate the Set Filter function. 
Enables/disables the display of short messages that match the scan criteria defined as
filter values in the Set Filter dialog box.  

Set Filter Enables/disables the Set Filter function. Scans the short messages in conjunction with
the Set Filter search criteria and displays the results in the list box. See To activate the
Set Filter function. 
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Compressed

The Compressed view displays the code(s) of the language(s) in which the message exists 

next to the message number for short texts, and 
next to the Long column for long texts.

In the above example the short text for message number 14 exists in English = 1, German = 2, Spanish =
4, and Italian = 5. The long text for message number 14 exists in English = 1.
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 To activate the Set Filter function 

1.  From the View menu, choose Set Filter.
A dialog box prompts you to enter the scan criteria:

The following options are provided:

Option Function 

Filter Values There are four fields available to enter search criteria. 

Or/And/Not You can include the conditional operands OR (default), AND or NOT between
the search items.

If you only fill one of the Filter Value fields, the conditional operands are
ignored.  

Find Whole WordsBy default, the scan is restricted to match entire words only and not parts of a
search string. 

Case Sensitive If marked, the scan is restricted to words in lower and upper case. 

In the example above, the search would be for the short message which contains both the words
"buffer" and "pool". If the operand NOT were specified, then the search would find all messages
which contain neither the word "buffer" nor the word "pool". 

2.  Enter the search criteria and choose OK.
The Set Filter function is enabled and the short messages matching the criteria are
displayed in the list box.

To deactivate the Set Filter function, disable Filter Display from the View menu. 
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Options Menu

Command Explanation 

Sample Creates a sample message to be used as a master for creating short messages. If the string 
0000 has been entered in the sample message, when copied, the string is replaced by the
number of the new message.

You can define one sample message for each language. 

Layout See Layout below. 

Shift Short 
Left

If enabled,  automatically shifts the text of a short message to the left margin when adding
a new message or choosing OK after modification. 

Size Startup Resizes the dialog to the size it had at startup. 

Full List Box Resizes the dialog to display the short message in full length. 

Confirm 
Window

Enables/disables a pop-up window to confirm: 

the new message number, 
that the short text is copied to the first line of the Long Text field if  "Short to Long"
was chosen, 
that the Sample text is copied to the Short Text field if Copy was chosen. 

Import Text 
File 

Imports a text file and converts it to a message file:

From
(text file)

Text file, from which the message will be generated. 

Generating messages modules:

The full path name of the file must be specified. Error number ranges
must not overlap for Natural system messages. 

To
(message file)  

Message file that will be generated. Default is the current library and
message file. For user-defined error messages the file must have the
name NnnAPMSL.MSG, where nn is the language code to be used.  

For further information on file formats refer to Recreating a Text File as described under
Error Messages Maintenance in the Natural Operations for Windows documentation.  

Export
Message File

Exports a message file and converts it to a text file. 

From
(message file)  

Message file, from which the text file will be generated. Default is the
current library and message file. For user-supplied error messages, the
file has the name NnnAPMSL.MSG, where nn is the language code to
be used. 

To
(text file)

Text file, which will be generated. 

For further information, refer to Recreating a Text File as described under Error Messages
Maintenance in the Natural Operations for Windows documentation. 
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Layout

Allows specification of valid message ranges to categorize messages. Overlapping of ranges is possible. A
new message can only be added if its number is within the range defined in the layout.

The layout definition applies to all languages. It is stored in the English message file.

To insert or delete rows, mark a row and press the insert or delete key. If the maximum of 18 rows is
displayed, you may have to delete or overwrite another row before you can insert a new one.

  

Help Menu

Displays SYSERR help text.
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List Box
The list box appears on the left side of the SYSERR window. It contains the short messages of one
language for one library. The short texts are preceded by the message number. The messages are sorted by
the message number in ascending order.

If  a message file contains more than 200 messages, for performance reasons, not all messages are read in
one step. When initializing the SYSERR window, up to 200 messages are read from the message file at
once, and about 30 of them are displayed in the list box. Scrolling down the list with the vertical scroll
bar, the next 200 messages are read and displayed as soon as the scroll bar reaches the bottom of the list 
box.
The command Read All as described in the section Menu Bar reads all remaining messages in one step.

The selected (highlighted) short message is the current message. It is displayed on the right side of the
SYSERR window. There, you can modify the short and long text. See also Fields below.

Fields
The following fields appear in the SYSERR window:

Field Explanation 

Sam. Output field displaying the text of a sample message if created. 

To create a sample message, see Sample in the section Menu Bar. 

Num. Modifiable field displaying the number of the current message. It  corresponds to the selected
message in the list box. 

It is possible to select another message number or to insert a new one.
The maximum message number for a library is 9999. The message number 0000 is not
allowed. 

Short Modifiable field displaying the short message text of the current message number. 

If you enter .C, the sample message for the selected language and library is copied into this
field. See also Sample in the Menu Bar section.

A new message can only be saved if text has been entered in the Short field. Therefore, if no
text is displayed for the current message, the message number is free and can be assigned to a
new message.   

Long Text Modifiable field displaying the long message text of the current message number.
It consists of three sections: 

Long description
Explanation
Action
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SYSERR Converting Natural Short Messages
If your terminal does not display certain characters correctly or if your terminal cannot display lower-case
characters, it is possible to convert the characters of Natural short messages with the SENSYS-D dialog.

 To convert characters of messages 

1.  From the SYSERR subdirectory Dialogs, select SENSYS-D.
Or select library SYSERR and enter command SENSYS-D.
The Functions for Natural Short Messages dialog box opens:

2.  Specify the error message range and the Language.
If desired, enter hexadecimal values in the Scan Value and Replace Value fields.  

3.  From the Function menu, choose an item:
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The following functions are provided:

Function Description 

Uppercase 
Messages

Converts messages to upper case. Once converted to upper case, you cannot
convert them back to lower case. To recover lower-case messages, unload the
error messages using SYSTRANS, save the transfer file and, when required,
reload the messages using SYSTRANS. See also the Natural SYSTRANS 
Utility  documentation. 

Scan Characters 
Hex

Scans for hexadecimal characters entered in the Scan Value field. 

Scan and ReplaceScans hexadecimal characters entered in the Scan Value and replaces them with
the hexadecimal characters entered in the Replace Value fields. 
This function may, for example, be useful to replace special signs.  

Replace using
SECSET-N

Replaces the characters of a message by the character set defined in the
subprogram SECSET-N. 
SECSET-N is stored in the SYSERR subdirectory Subprograms. 

Display Message 
Hexadecimal

Enables/disables the display of a message in hexadecimal format. 

Display Char
Table for 
Terminal

Enable/disable this function to find out the characters your terminal can
represent.  

Processing Log Enable/disable the processing log to view the results of the executed functions. 
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SYSERR User Exit USR0020P
The user exit program USR0020P in the library SYSEXT is provided to read messages from the FNAT or
FUSER system file. Thus, it is possible, for example, to have long messages displayed in an application
(as part of your own user-defined help system) without having to use the library SYSERR.

Log on to the library SYSEXT and enter the command MENU. On the list provided, mark the program
USR0020P with a question mark (?); a window is displayed, on which you can select the function to be
executed for the program. If you enter an I , detailed information on the use of USR0020P is displayed.
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